
Help for SPRY Mail

For information on SPRY Mail choose one of the categories listed below. To learn how to use Help, press F1.

Getting started
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user interface.

Using SPRY Mail
Step by step instructions explaining how to 
perform common tasks.

SPRY Mail reference
Reference information about the user interface.
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The SPRY Mail interface
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What is SPRY Mail?

SPRY Mail provides an efficient and easy-to-use way to send, receive and store Internet mail. It provides: 

• Sophisticated features for composing and saving mail.

• The capability to read, process, and compose mail when offline. You can also decide whether to leave 
mail on the host or automatically copy it to your PC.

Mail requires two things:
• A mail host must be set up on your local network or on the Internet. This is a machine (usually running 

UNIX) that receives your e-mail. 

• A POP3 server must be running on the mail host in order for you to receive mail. Contact your network 
system administrator or Internet Service Provider to make sure that you have a POP3 mail host.



The SPRY Mail interface

SPRY Mail's main window appears below. Click the screen to learn more about Mail’s interface.



About Internet e-mail addresses

Most Internet addresses are formatted name@place.ext, where name is the sender's name and place.ext is the 
sender’s domain name. The domain name usually represents the company (com), university (edu), or 
organization (org) from which the mail is routed. For instance, a message sent by holmes@mycroft.com might 
be from user “holmes” at Mycroft Inc.

Commercial online services each use a proprietary e-mail address. When sending Internet mail to an online 
service, you will need to modify the address as listed below.

Service Native address Internet address

CompuServe Two sets of numbers, 
separated by a comma: 
76543,123

Change the comma to a period and send 
to address@compuserve.com: 
76543.123@compuserve.com

America Online First initial and last name: 
sholmes

Send to address@aol.com: 
sholmes@aol.com

Delphi First initial and last name: 
sholmes

Send to address@delphi.com: 
sholmes@delphi.com

MCI Mail Name or 7 digit number: 
al_einstein or 1234567

Send to address@mcimail.com: 
al_einstein@mcimail.com or 
1234567@mcimail.com. Omit any 
hyphens in the number.

Prodigy Assorted numbers and 
letters: UMH999A

Send to address@prodigy.com: 
UMH999A@prodigy.com

TIP Mail also supports UUCP style addressing; therefore, holmes@mycroft.com could also be addressed as
mycroft.com!holmes.



browse button
Makes it easy to navigate the drives and 
directories on your computer.

Read button
Opens the messages that is currently selected. If more
than one message is selected, each is opened in a 
separate window. 

Messages you haven't read are shown with an 
unopened envelope icon.  Messages that you have
read are displayed with an open envelope.  
Messages with an attachment are indicated with an

 icon.

To read a message in another folder, you must first 
open the folder to display the messages in it.

Save button
Saves the message that is currently open or selected 
to a text file. If more than one message is selected, 
they are combined into a single file.

Print button
Prints the selected message(s).

Compose button
Displays the Compose Mail window so you can create 
a mail message.

You can send a message to one or more persons. To 
address a message, either type the recipients' names 
in the To field, or choose names from the address list. 

Reply button
Replies to the message that is currently open or 
selected.    If a message has multiple recipients, you 
can reply just to the sender of the message or to 
everyone who received it.

When you reply to a message, the sender's name is 
entered in the To box, and the subject of the original 
message is entered in the Subject box, preceded by 
the prefix Re: (for Reply). You can choose to include 
the contents of the original message in the message 
body.

Forward button
Forwards the message that is currently open or 
selected.    



You can include your own comments in the body of the
message. Files that are attached to a message are 
forwarded along with it.

Previous button
Cycles through mail messages in the mail list. If you 
have selected multiple messages to read, Previous 
and Next will only scroll through the selected 
messages.

Next button
Cycles through mail messages in the mail list. If you 
have selected multiple messages to read, Previous 
and Next will only scroll through the selected 
messages.

Font button
Changes the font used in the current window. You can 
change the font used for the main window (where 
folders and messages are displayed) and the 
Compose Message window. 

Delete button
Deletes the currently selected message(s).

Disconnect button
Disconnects from the current mail server so you can 
work offline.

Folders list
Displays all of your mail folders. A plus sign (+) 
indicates that a folder has subfolders. To view the 
subfolders, double-click the plus sign. A minus sign (-) 
indicates that subfolders are displayed. To hide the 
subfolders, double-click the minus sign.

When you first use Mail, you will see four folders: 
Remote Inbox, Outgoing Mail, Sent Mail and Waste 
Basket. Of course, you can create your own custom 
folders for storing mail. 

Sort by buttons
Control how your Mail messages are arranged in the 
main window. Click From, Date, Size, or Subject to sort
your messages.

By default, Mail sorts in ascending order (A-Z, smallest
to largest, oldest to newest). To sort in descending 
order, click the Sort in Ascending command on the 
View menu to toggle it to Sort in Descending order.



Mailbox window
Lists the messages stored in the current folder.

 



Using SPRY Mail

The following topics provide step-by-step instructions on common tasks.

    Getting started
    Sending messages
    Working with messages you’ve received
    Working with folders
    Working with address books
    Setting Mail options
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Using SPRY Mail

The following topics provide step-by-step instructions on common tasks.

    Getting started
    Sending messages
    Working with messages you’ve received
    Working with folders
    Working with address books
    Setting Mail options

Choosing an inbox 

Working offline 

Choosing a font for Mail 

Choosing message headers 

Setting confirmation options 

Choosing how messages are sent



Starting Mail

To start SPRY Mail: 

1. Switch to the Program Manager and open the group that contains the SPRY Mail icon.

 Spry Mail icon
2. Double-click the Mail icon.

The SPRY Mail Login dialog box will appear, asking you to fill out information about your mail account; 
you must login in order to access mail.

NOTE The very first time you start Mail, you will be asked to specify a directory for your mail folders. See Mail 
Folder Directory for more information.



Logging into Mail

Each time you start Mail, you will be asked to provide information about your mail account.

To log into Mail: 

1. Type the name or the IP address (such as 165.121.100.20) of the host on which the POP3 server is 
loaded. 

If you have a hosts file, its contents will appear in the Host box for you to select. (You may or may not 
have a hosts file, according to the TCP/IP transport you are using and how your system is configured.)

2. Fill out your username on the host you specified. This may be your "login name" on that system.

3. Fill out your password on the host you specified.



Automating your login

Mail automatically remembers your e-mail hostname and username. You can also have Mail remember your 
password.    The next time you connect to Mail, the login dialog box will be filled out. 

To automate your login: 

1. Choose Login from the Options menu.

2. Check the Remember Password option.

You may want to bypass the login dialog box altogether using one of Mail's command line options. 

Parameter What it sets

-h Hostname or address of your e-mail host
-u Username on the e-mail host
-p Password on the e-mail host

For example, c:\air\bin\airmail -hhost1.narnia.com -ulucy -paslan would try to connect to host 
"host1.narnia.com" and login as user "lucy" with password "aslan". Notice that you don't type a space between the 
parameter and the option.

TIP You can create an icon or shortcut for Mail that will automatically log you in and connect to your mail host.
Under Windows 3.x, choose New from the File menu, create a new Program Item, and in the Program 
Item Properties dialog box type the command line options in the Command Line box. Under Windows 
95, right click to display the context menu, choose New Shortcut and type the command line option in the 
Target box.



Choosing a mail folder directory

The first time you start Mail, you will be asked to choose the directory used to store your mail folders. 

To choose a mail folder directory: 

1. Start Mail.

2. Type the name of the directory in the Directory box. 

Mail suggests the subdirectory \...\DATA\MAIL in SPRY directory. You can specify a different path and 
filename; if the directory does not exist, Mail will create it for you.



Overview of messages

After you finish composing a mail message you can send it by clicking the Send button.

What happens when you send a message
When you press the Send button, your mail will be sent immediately if you are connected to your mail host. If you 
are working offline, the mail will be moved to the Outgoing Mail folder and sent the next time you connect to the 
host.

If you are not connected to the host but want to immediately send a mail message, you can choose Send Now 
from the Mail menu. Mail will attempt to connect to your host and send your mail.

When a mail message is sent, "Message sent successfully" will appear in the status bar.

The first time you send mail
The first time you try to send mail, a dialog box will appear asking you to specify the Return Address and SMTP 
Host address for your mail host.

By default, Mail uses the SMTP method to send mail. Your Return Address should already have been filled out, if 
you provided the information during installation (this is the same as your e-mail address). Your SMTP host is 
usually the same as the host you connect to when you login. Type the address for that host in fully qualified 
Domain Name System format (for example, lucy.narnia.com), unless you know that you use a different SMTP 
host.

If you prefer to send mail using POP3, click Cancel. In the Preferences dialog box change the Send Method box 
to POP3, then re-send the mail message.



Addressing a message

There are two ways you can address a mail message: you can type the recipient's e-mail address, or you can 
select the address from an address book. 

To address a message: 

1. Type the e-mail address of the person(s) in the To: box, or click the button to display the current address 
book. This information is required. See Internet e-mail addresses for more information.

2. Use the Subject box to describe the message subject. This is optional; you can fill it out however you 
want.

3. If you want to send a copy of the message to someone else, type his or her name in the CC: and/or BCC:
boxes, or click the button to display the current address book. 

The names of all CC: (carbon copy) recipients will appear in the message received by the original 
addressee(s) (that is, appearing in the To: box). Names of BCC: (blind carbon copy) recipients will not 
appear in the message sent to the original addressee.

See Also

Using Address Books



Creating a message

To compose a message: 

1. Choose Compose New Message from the Mail menu.

2. Type the body of your message. You can use any of the standard editing keys shown below.

To: Press:

Move one character or line arrow keys

Move one word to the left CTRL+LEFT ARROW

Move one word to the right CTRL+RIGHT ARROW

Move to the start of the line HOME

Move to the start of the message CTRL+HOME

Move to the end of the line END

Move to end of message CTRL+END

Start a new paragraph TYPE

Delete the current character DEL

Delete the character to the left BACKSPACE

Move right five spaces TAB

You can also use Cut, Copy, and Paste from the Edit menu to manipulate your message text. Additionally,
you can insert text from a file using the Insert Text File  command.

TIP Clicking the Hide Header button will give you more room to type your message. 



Spell checking a message

If you have any of Microsoft’s spelling dictionaries installed on your computer, you can check the spelling of your 
messages. 

To spell check a message: 

1. Compose your message text.

2. Choose Spell Check from the Edit menu.

3. The Spell Check dialog box will appear and immediately begin checking your message.

4. For each word that appears in the Not In Dictionary box, do one of the following:

To: Click the:

Accept the spelling in the Change To 
box.

Replace the misspelled word with a 
selection in the Suggestions box.

Replace the misspelled word with the 
spelling you type in the Change To box.

Change button    

Add the word to the custom dictionary 
selected in the Add Words To box.

Add button

Leave the word unchanged. Ignore button

Requesting a return receipt

You can have Mail notify you when your mail message is received by the recipient’s mail server. This does not 
acknowledge that the person you are sending mail to has received the mail, only that the mail arrived at the server.

To request a return receipt: 

1. From the Compose Mail window, click the Options button.

2. Check the Return Receipt box.

When the remote mail server receives the message, it will send you a mail message titled “Returned Mail:
Return Receipt.” This message includes the body of the message you sent.

NOTE This option is not automatically remembered, so each time you want to receive a return receipt you must 
check this box.



Setting message options

For each mail message you send, you can request a return receipt and control the method used to encode any 
files attached to the message.

To set message options:

1. In the Compose Mail dialog box, click the Options button. The Sending Options dialog box will appear.

2. Choose the type of encoding you want to use for any file attachments. MIME is probably the most efficient
choice, depending on which mail program is used by the message recipient. If there is a problem using 
MIME, try using UUCODE.

Mail remembers the option you choose in this dialog box and uses it for all mail messages until you 
change it.

3. To receive a message acknowledging that the mail message was received by the remote mail server, 
check the Return Receipt box. This does not acknowledge that the person you are sending mail to has 
received the mail, only that the mail arrived at the server.

Mail does not remember this option; you must select this option each time you want to receive a return 
receipt.



Attaching a file

You can include or "attach" one or more files to a mail message you send. Mail lets you attach binary files (such as
a program, or a word processing document) or text files. 

To attach a file to a message: 

1. In the Compose Mail dialog box, click the Show Attachment button. A new pane will appear below the 
main Mail window.

2. Click the Attach button, and the Attach File dialog box will appear. Choose the file that you want to 
attach. You can also drag a file from the Windows File Manager (or any other program that supports drag 
and drop) and drop it anywhere in the Mail window.

The icon for the file will appear in the attachment pane. 

NOTE You can attach several files to a single mail message, but note that some mailers have a limit to the size 
and number of attachments they can accept. If you are working with large files, consider attaching them to
separate mail messages.

3. When you have finished attaching files, you can choose Hide Attachment to return to your Compose Mail
dialog box, if desired. 

When you click the Send button, Mail will attach the file. Text files will be attached quickly, but binary files may take
longer since they must be uuencoded, as described below. 

About file encoding
Binary files must be converted to a format that allows them to be sent over the Internet. This is called “encoding.” 
Mail includes two methods for doing this: MIME and UUCODE. You can set the option that is used by clicking the 
Sending Options dialog box.

The recipient of your mail message must have a mail program or utility that can read MIME or uuencoded files, or 
the mail message may appear as unintelligible text on his or her screen. 



Checking for new messages

When you are connected to your mail host, Mail will check for new messages as often as you specify. Any new 
messages will appear in your Inbox with a symbol representing an unopened envelope.  

To change how Mail checks for new messages: 

To manually check for messages, choose New Messages from the View menu. If you are not connected to 
your mail host, Mail will make a connection in order to check for new messages.

To change how often Mail checks for new mail, use Check new mail every __ minutes option in the 
Preferences dialog box. The default is 10 minutes.

To change how Mail notifies you of new messages: 

To change how Mail notifies you of new messages, use the Notification options in the Preferences dialog 
box. 

When Mail is running, its icon will indicate whether you’ve got 
any unread messages in your inbox.

Reading a message

To read a message: 

1. If necessary, expand the folders list to display the folder with the message you want to read.

2. Double-click to open the folder containing the message you want to read.

3. From the message list, select the message you want to read.

4. Press ENTER, or choose Open from the Mail menu.    If necessary, click the scroll bar or press the PAGE 
DOWN key to read the entire message.

5. To read other messages in the list, click the Previous or Next button, or choose Previous or Next from the 
View menu.

6. To close a message window, press ESC or CTRL+F4.



Replying to a message

You can reply to a message that's open or selected in the message list.

To reply to a message: 

1. Address your message by choosing Reply from the Mail menu. You will be asked how you want to reply to
the message:

To Sender The reply message will be sent to the person who sent the mail to you. This is the default 
reply method.

To Sender Include The reply message will be sent to the sender, as described above, and will include
the original received message.

To All The reply message will be sent to the person who sent the mail to you and all others who the 
mail was originally sent to.

To All Include The reply message will be sent to all, as described above, and will include the original 
received message. 

2. Type your reply in the Compose Message window.

3. Click the Send button.

TIP If you do not want to have to specify a reply method each time you reply to a message, you can disable 
the prompt for reply method that appears by unchecking Reply Method in the Confirmation dialog box. In 
this case, Mail will remember the last reply method you used before disabling the option and use it for 
future messages.



Forwarding a message

You can forward a message that is either open or selected in a message list. The original message will be 
enclosed by two lines, Begin Message and End Message. You can add your own text to the message before you 
forward it.

To forward a message: 

1. Choose Forward from the Mail menu.

2. In the To box, specify the recipient(s) of the message.

3. To add comments, move the insertion point to the message body and type.

4. Choose the Send button.



Printing a message

You can print a mail message that is open, or print one or more messages selected in a message list. 

To print a message: 

1. Open a message, or select the message(s) in a message list.

2. Choose Print    from the Mail menu.

NOTE Attached files are not printed; they must be printed from the application used to create them.



Deleting a message

To delete a message: 

Select one or more messages and choose Delete from the Mail menu or click the Delete button. You can 
also delete the message you are currently reading.

Notes
You can control whether or not Mail displays a prompt asking you to confirm each deletion. For more 

information, see the Confirmation dialog box. 
If you delete a message from either a folder or the Local Inbox, it will be moved to the Waste Basket folder. 

This folder will be emptied and all messages deleted when you exit Mail; see Empty Wastebasket on Exit . If this 
option is not checked, the messages will not be deleted unless you select them in the Waste Basket folder and 
choose Delete. 

Mail deleted from the Remote Inbox folder cannot be recovered. Use caution when deleting mail from this 
folder. 

You can have Mail automatically open the next message when you delete the message you are currently 
reading by checking the Open Message After Delete command on the Options menu.



Opening and saving an attachment

Attached files appear as icons in the attachment pane of a message. Mail lets you open or save the file attached 
to the message.

To open an attachment: 

In the attachment pane, double-click the file icon.

To save an attachment: 

In the attachment pane, click the Save button.    
To save a selected file under a different filename, type it in the File Name box. To save the file in a 
different directory, choose the drive and directory where you want to save the file.

To save multiple attachments in one step: 

In the attachment pane, click the Save All button.    
Specify the directory you want to save the files in. The files will be saved using their original filenames.



Saving a message as a text file

You can save one or more Mail messages to a file. Only the text information in the message will be saved.

To save a message as a text file: 

1. Select one or more messages from the Mailbox. You can also save a message you are currently reading.

2. Choose Save from the Mail menu.

3. Specify a name and location for the file in the Save Mail dialog box.



Sorting messages

You can sort the mail messages according to the name and address of the mail sender, the date the message was
sent, and the size and subject of the message. 

To sort messages: 

1. Specify which field is used to sort your messages by choosing Sort by Sender, Sort by Date, Sort by Size,
or Sort by Subject from the View menu. You can also click the From, Date, Size, or Subject button in the 
mail window. 

2. Select the sort order by choosing Sort by Ascending or Sort by Descending from the View menu (this 
menu option will change depending on how you are currently sorting messages).

By default, the mail will be sorted in ascending order, as follows:

From: alphabetical, a-z

Date: oldest to newest

Size: smallest to largest

Subject: alphabetical, a-z

NOTE The date of the message reflects the date it was sent, not the date the message was received. 



Finding a message

Mail provides a Find feature to enable you to locate a message in a list of messages. You can search for any text 
in the message detail header: From, Date, Size, or Subject.

To find a message: 

1. From the Edit menu, choose File.

2. Fill in the box with the information you want to find. Mail’s search feature is case-sensitive; therefore, you 
must type the exact text you want to find. Mail searches the From, Date, Size, or Subject fields in a list of 
messages.

3. Click OK to search. Mail will find and highlight the first occurrence of the text or tell you the text could not 
be found.

4. If you want to search again, choose Find Next from the Edit menu or press F3. 

Notes
Mail does a search starting from the currently highlighted message down to the bottom of the message list. 

You may, therefore, want to highlight the first message in order to do a search of the entire list. Mail will only search 
the messages currently being displayed.

You can use the Find Next command to select all occurrences of the search text. This makes it easy to work 
with a group of selected messages (perhaps you want to move all of the messages from your boss “Fred”).



Selecting messages

You will need to select Mail messages in order to read, save, or delete them. 

To select a message: 

Click the message name in the message list. 

To select multiple messages: 

Hold down CTRL and click the messages.

To select a range of messages: 

Hold down the SHIFT key, and click the first and last messages in the range.



Overview of mail folders

Mail folders provide two benefits: 

Folders help you organize your mail. Instead of storing all your mail in the inbox, you might organize your 
mail according to subject (by project or task) or person (the individual or department who sent the mail).

If you store mail in folders, you can access the mail when you are working "offline" (that is, not connected to 
your mail host).

When you first use Mail, you will see four folders: Remote Inbox, Outgoing Mail, Sent Mail, and Waste Basket. 
These are Mail’s system folders and cannot be removed. Of course, you can create your own custom folders for 
storing mail. 

The Folders list displays all of your folders. A plus sign (+) indicates that a folder has subfolders. To view the 
subfolders, double-click the plus sign. A minus sign (-) indicates that subfolders are displayed. To hide the 
subfolders, double-click the minus sign.

See Also

Storing messages in folders 
Creating a new folder 
Moving a folder 
Deleting a folder 



Storing messages in folders

You can move or copy messages to mail folders. When you move a message, it is removed from its original 
location. When you copy a message, a copy is stored in the original location and the new folder.

To move a message in a folder: 

Select one or more messages, and drag the message to the folder in the folders list. You can also choose 
Move from the Mail menu and specify the folder in which you want to store the message.

To copy a message in a folder: 

Select one or more messages, hold down the CONTROL key and drag the message to the folder in the 
folders list. You can also choose Copy from the Mail menu and specify the folder in which you want to store the 
message.



Creating a new folder

You can create folders for storing and organizing your mail. Folders can be contained in other folders; these are 
called subfolders.

To create a new folder:

1. Choose New Folder from the Mail menu.

2. In the New Folder Name box, type a name for the folder.

3. If you want to create subfolder, choose the name of the master folder in the Subfolder Of box. You can 
create folders many levels deep.



Moving a folder

You can move a folder or subfolder to another position in the Mail folder tree. 

To move a folder: 

Select a folder and drag it to the destination folder. 
- OR -

Choose Move Folder from the Mail menu, and then specify the destination to which you want to move the 
folder.



Deleting a folder

When you delete a folder, any messages and subfolders it contains are deleted. You will be asked to confirm that 
you want to delete the folder. 

To delete a folder: 

1. In the folders list, select the folder you want to delete.

2. Choose Delete Folder from the File menu, or press the DELETE key.



Overview of address books

Since many e-mail addresses on the Internet are long and may be hard to remember, you probably want to create 
an address book to store e-mail addresses and the "alias names" that represent them. You can then select an 
alias name instead of an e-mail address. 

You can also create group address books, allowing you to send mail to groups of people. For example, suppose 
you often send mail to your co-workers Tom, Dick, and Harry. You could create an alias name Co-Workers 
associated with their three addresses:

Alias name Co-Workers
Internet address tom@company.com,dick@company.com,harry@company.com

You can then select the alias name Co-Workers in the address book instead of having to select three e-mail 
addresses.

You may find it useful to create several different address books—perhaps you want separate personal and 
business address books. You can create as many address books as you want.

See Also

Creating an address book 

Using an address book



Creating an address book

While you can add your own e-mail addresses to the default address book that comes with Mail, you will probably 
want to create your own address book. You can create as many address books as you want. Address books are 
stored as files with the file extension .ALS.

To create an address book: 

1. Choose Compose New Message from the Mail menu to open the Compose Mail window.

2. Click the To: button.

3. Click the Open/New button to create a new Address Book. The Open/New Address Book dialog box will 
appear, allowing you to specify a name and location for the address book.

See Also

Address Book



Adding a new address

You can store the names of mail recipients you frequently send messages to in your address book.

To add a new address: 

1. Choose Compose New Message from the Mail menu to open the Compose Mail window.

2. Click the To: button.

3. Click the Add button.  

4. Type a short, distinctive name in the Alias Name box. You will select this name when addressing e-mail 
messages.

5. Type the user’s e-mail address in the Internet Address box. You can also click the Paste button to paste 
an address from the clipboard.



Deleting an address

To delete an address: 

1. Choose Compose New Message from the Mail menu to open the Compose Mail window.

2. Click the To: button.

3. Click the Delete button.  



Editing an address

To edit an address: 

1. Choose Compose New Message from the Mail menu to open the Compose Mail window.

2. Click the To: button.

3. Click the Edit button.  

4. Update the information in the Alias Name or Internet Address boxes, as necessary.



Creating a personal address group

Just as you can add individuals to your address book, you can also add groups of people. For example, you might 
create a “Sales” group containing the addresses of all the people in the sales department. 

To create a personal address group: 

1. Choose Compose New Message from the Mail menu to open the Compose Mail window.

2. Click the To: button.

3. Click the Add button.

4. Type a name in the Alias Name box. For example, you might enter “Sales.” 

5. Type the Internet addresses for each person in the group in the Internet Address box. Separate each 
address with a comma. You can paste an address from the clipboard by clicking the Paste button.

For example, you might type: 
glenn@company.com,betsy@company.com,jason@company.com

Notes

The Address Book Detail dialog box accommodates most e-mail addresses, but to create a very large group 
you may need to edit the .ALS file in a text editor like Windows Notepad, using the following format: 
Groupname:Address1,Address2,Address3 (etc).

The maximum size of an Internet address is about 1024 characters. When creating a large group in the 
address book, do not exceed this length, as this may produce an "overflow header" error and the message will not be
sent. 



Choosing an inbox

Mail gives you two options for incoming mail:

Remote inbox leaves your mail on the mail host until you move it to a local folder or delete it. This option 
lets you easily access mail from different PCs (such as work, home, and on the road), but limits your ability to work 
"offline" (that is, disconnected from your mail host).

Local inbox moves your messages to your local machine. This option lets you work offline, but requires 
more disk space on your local PC.

To choose an inbox: 

1. Choose Preferences from the Options menu.

The Inbox Location area in the Preferences dialog box will indicate which inbox you are currently using. 

2. Click the Change button to select either a local or remote inbox. 

The change will not take effect until you exit and restart Mail.

Guidelines for choosing an inbox
Here are some guidelines for deciding whether to use a local or remote inbox.

If you... Choose this option:

Work on a network and primarily work 
on one machine.

Local inbox so that all of your 
mail is stored on one machine.

Work on a network, but often access 
mail from machines other than your 
own.

Remote inbox so that you can 
access your old mail from any 
PC.

Access mail over a phone line and want 
to keep your connection time at a 
minimum.

Local inbox so that new mail is 
moved to your PC and you can 
work offline.

Access mail over a phone line and have 
a slow phone line or a lot of large mail 
messages.

Remote inbox so that your new 
mail is not automatically moved 
to your PC. 

Are often disconnected from your mail 
host.

Local inbox so that all new mail is
moved to your PC and you can 
work offline.

Are still unsure about which option to 
use.

Local inbox.

Working offline

You can start Mail and work "offline" without connecting to your mail host. While offline, you can still read, reply to, 
forward, and print mail in your local folders, and compose new messages. Any mail you compose will be moved to 
the Outgoing Mail box and will be sent the next time you connect to your mail host.

To work offline:

If you aren’t running Mail, Check the Work Offline box in the Mail login dialog box before you log in. For 
security reasons, you must still type your mail host, username, and password.

-OR-
If you are running Mail, choose Disconnect from the Mail menu or click the Disconnect button.

To connect to your mail host:



Choose Connect from the Mail menu, or click the Connect button on the toolbar.
-OR-
Choose Send Now from the Mail menu or choose New Messages from the View menu.



Choosing a font for Mail

You can change the font used for both the main window (where folders and messages are displayed) and the 
Compose Message window. 

To choose a font for Mail: 

1. Change to the window (either the main window, or the Compose Message window) for which you want to 
change the font.

2. Choose Font from the Options menu.

3. Choose the font, style, and size you want to use. You can preview the font in the Sample area.

Notes
Fonts in the Compose Message window are for display only—your message will not be displayed in that font

when it is received.    
Only monospaced fonts can be displayed in the Compose Message window; this ensures that your message

is correctly formatted by Mail before sending.



Choosing message headers

Mail lets you specify which mail header information to display. The header includes information such as the mail 
subject, the message recipients (To:, CC:), the date, and more.    

To choose which message headers are displayed: 

1. Choose Message Headers from the Options menu.

2. Choose the header information you want to see. 

To see all of the header information, click the All option. 

To omit all of the header information, click the None option. 

To select which fields to include, click the Selection option and select the fields you want to display.



Setting confirmation options

You can choose whether or not a confirmation prompt appears each time you delete a mail message.    You can 
also choose whether you will be prompted for a reply method each time you reply to a message.

To set confirmation options: 

1. Choose Confirmation from the Options menu.

2. Use the Remote Message Delete box to control whether a prompt appears when you delete a message. 
This confirmation option only works for messages deleted from the Remote Inbox; messages in other 
folders are simply moved to the Waste Basket folder. 

3. Use the Reply Method box to control whether a prompt appears when you reply to a message.    The 
prompt lets you address the message to the sender or to all original recipients, and lets you specify 
whether or not the text of the original message is included.



Choosing how messages are sent

Mail supports two protocols—SMTP and POP3—for sending Mail messages. SMTP should work in most cases; 
contact your mail administrator if you are not sure which protocol to use.

To choose how messages are sent: 

1. Choose Preferences from the Options menu. 

2. Under Send Mail By, click the method you want to use.

SMTP (Simple Mail Transfer Protocol) is the default. If you click this option, you must type your return mail
address in the Return Address box.

POP3 (Post Office Protocol) will work if your mail host features the extended POP3 protocol. 



Saving sent mail

Mail allows you to automatically save a copy of each message you send. Selecting this option will increase the 
amount of disk space required by Mail to store your messages.

To automatically save sent mail: 

1. Choose Preferences from the Options menu. 

2. Under Compose, click Keep a copy of outgoing messages in Sent Mail folder. 
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Read

Displays the currently highlighted mail message(s). If more than one message is highlighted, you can use the 
Previous and Next buttons to browse the messages.



Save Mail

Saves a mail message to a text file. This only saves the body of a mail message; to save an attachment, use the 
Save button in the Attachment window. 

File Name Type a new name for the file, or select an existing name from the list. A filename can 
contain up to eight characters, plus a three-letter extension.

Save File As Type Changes the file extension used to save the file. By default, Mail saves the file as text 
file with a .TXT extension.

Drives Select the drive where you want to store the document.

Directories Select the directory where you want to store the document.

NOTE Saving a mail message using an existing name will overwrite any information currently in the file—it will 
not append the message to the file.

See Also

Saving a message as a text file 



Move Message

Moves a message from one folder to another folder. You should select the message or messages you want to 
move before choosing this command.

The Move Message dialog box displays your current folder list. Click on a folder name to select it (double-click on 
a folder name to display any subfolders). 

Click OK; the message(s) will be moved to the folder you specified.



Copy Message

Moves a message from one folder to another folder. You should have selected the message or messages you 
want to move before using this command.

The Copy Message dialog box will display your current folder list. Click on a folder name to select it (double-click 
on a folder name to display any subfolders). 

Click OK; the message(s) will be copied to the folder you specified.



Delete

Deletes the currently selected message(s). If you’ve got the Confirm On Remote Message Delete option 
checked, a prompt will appear confirming whether or not you want to delete each message.

See Also

Deleting a message 



Print

Controls how the currently selected message(s) are printed.    

Printer Displays the name of the active printer and the printer connection.

Print Range Specifies which messages to print. Mail always prints All of the messages that are 
selected in the current folder.

Print Quality Allows you to select the Print Quality to use to print the messages.    This will vary 
depending on which printer you are printing to.    Usually, you should not change the 
default setting.

Print To File Prints a document to a new file on the drive you specify instead of routing it directly to 
a printer. When you click OK, a dialog box appears so that you can type a new 
filename. 

Copies Specifies the number of copies you want to print.

Collate Copies Organizes pages when you print multiple copies. A complete copy of the first 
document will be printed before the second copy is printed.

Setup Changes the current printer and connection. See your Windows documentation for 
more information about this dialog box.

See Also

Printing a message 



Compose New Message

Displays a blank mail form for you to compose an outgoing mail message. You can type your message using 
standard editing keys, paste information from Mail messages or other Windows applications, and attach files to 
your message.

See Also

The SPRY Mail interface 
Composing messages 



Reply

Lets you choose how you want to reply to the message that is currently highlighted.

To Sender The reply message will be sent to the person who sent you the original mail message.

To Sender Include The reply will be sent to the sender and will include the original message.

To All The reply message will be sent to the person who sent you the mail and all others to 
whom the mail was originally sent.

To All Include The reply message will be sent to all original recipients and will include the original 
message. 

See Also

Replying to a message 



Forward

Copies the message that is currently highlighted into a new message so that you can forward it to another person.

See Also

Forwarding a message 



Disconnect

Disconnects from the current mail server so you can work offline.

See Also

Working offline 



Send Now

Sends any outgoing messages that are in the message queue waiting to be sent. 



Create New Folder

Creates a new folder for storing and organizing your mail. Folders can be contained in other folders; these are 
called subfolders.

New Folder Name Type a name for the folder.

Subfolder Of If you want to create a subfolder, choose the name of the master folder in the box. You
can create folders many levels deep.

See Also

Overview of Mail folders 



Move Folder

Moves the selected folder to another position in the Mail folder tree. Note that Mail lets you create subfolders (that 
is, a folder within a folder) to help you organize your messages.

Choose the destination to which you want to move the currently selected folder. Folders containing subfolders are 
indicated with a + sign on the folder icon; to display the subfolders, double-click the folder icon.

See Also

Overview of Mail folders 



Delete Folder

Deletes the currently selected mail folder. A prompt will appear confirming whether or not you want to delete the 
folder.

See Also

Overview of Mail folders 



Exit

Ends your Mail session. If you are currently composing a message, a prompt will appear asking you to confirm 
whether you want to exit. Any unsent messages will be deleted if you exit.



Cut, Copy, and Paste

Moves text between Mail and the Windows clipboard. These commands are useful for composing an outgoing 
message and copying text from a message you received.

Cut Copies the selected text and places it on the Windows clipboard.

Copy Removes the selected text and places it on the Windows clipboard.

Paste Inserts a copy of any text on the Windows clipboard at the current cursor location.

See Also

Creating a message 



Insert Text File

Attaches a text file to a mail message. The file will be inserted into the body of your message at the current (or 
most recent) cursor position.

Filename Select or type the name of the file you want to attach. 

Drives Select the drive that contains the file you want to attach.

Directories Select the directory that contains the file you want to attach.

Network Opens the Connect Network Drive dialog box so that you can make a connection to a 
network drive. For more information, choose the Help button in the dialog box.

See Also

Creating a message 



Find

Searches the From, Date, Size, or Subject fields in a list of messages.

Find What Specifies the exact text for which you want to search.

NOTES

Mail starts its search at message that is currently highlighted, and works down to the bottom of the message
list. To search the entire list, you should highlight the first message in the list.

Mail search strings are case sensitive (that is, William and william are treated differently), so try alternate 
capitalization if you can’t find a particular message.

If you want to search again, choose Find Next from the Edit menu or press F3.

See Also

Finding a message 



Find Next

Finds and selects the next occurrence of the text specified in the Find What box.

See Also

Find
Finding a message 



Spell Check

Checks the spelling in the current mail message. This command is available if you have any of Microsoft’s spelling
dictionaries (such as those included with Microsoft Office or Microsoft Word) installed on your system.

Not In Dictionary Displays a word not found in the main dictionary or open custom dictionaries.

Change To Type or select a word from the Suggestions list to replace the word not found in the 
open dictionaries.To delete the word from the document, delete the text in the Change
To box, and then choose the Delete button.

Suggestions Lists suggested replacement words from the main dictionary.

Add Words To Selects the dictionary to which you want to add the word in the Not In Dictionary box 
if the word is correctly spelled but not found in the main dictionary—for example, the 
name of a person or city that you type often.

Change Changes the word in the Not In Dictionary box to the word in the Change To box.

Add Adds the word in the Not In Dictionary box to the dictionary selected in the Add 
Words To box.

Ignore Does not correct the spelling of the word in the Not In Dictionary box.

See Also

Spell checking a message 



New Messages

Checks the Mail server for any new messages. Any new messages you’ve received will appear in your inbox. You 
can control this setting using the Preferences command.



Split

Moves the splitter bar so you can set the size of the two window panes in Mail.



All Details, Partial Details

Controls whether or not Mail shows all of the details for your mail messages. By default, Mail shows All Details for
each mail message: the sender, date, size, and subject.

Partial Details Clear the Date box to hide the date the message was sent. Clear the Size box to hide 
the size of the message.



Sort by options

Controls how your Mail messages are arranged in the main window. By default, Mail sorts in ascending order (A-Z,
smallest to largest, oldest to newest). To sort in descending order, click the Sort in Ascending command to toggle
it to Sort in Descending order.

Sender Sorts messages alphabetically by the name of the sender.

Date Sorts messages by date. Mail displays the date the message was sent, not the date it 
was received.

Size Sorts messages by size.

Subject Sorts messages alphabetically according to the name of the subject.

Sort in Ascending/
Descending Controls whether the Mail sorts your messages in ascending or descending order. This

toggle command changes depending on how you are currently viewing your mail 
messages. If Sort in Ascending is on, clicking the command will change it to Sort in 
Descending.

See Also

Sorting messages 



Previous and Next

Cycles through mail messages in the mail list. If you have selected multiple messages to read, Previous and Next 
will only scroll through the selected messages.

NOTE Mail ignores the date a message was sent when it cycles through Previous and Next. Instead, Mail looks 
at the sort order: the message above the current message is always "previous," and the message below 
the current message is always "next."



View options

Displays or hides Mail’s toolbar and status bar.

Toolbar Place a check by this command to view the toolbar.

Status Bar Place a check by this command to view the status bar.



Login Options

Specifies the host and user login name. 

Host Enter the address of the machine to which you want to connect. You can enter a fully 
qualified domain name (such as circe.odysseus.com), IP address (such as 
165.121.100.20), or a host name stored in your hosts file.

Username Specify your username.

TIP Although you can’t specify a password in this screen, you can check the Remember Password option in 
the dialog box that appears when you login to have Mail enter your password automatically.

See Also

Starting Mail
Logging into Mail 



Preferences

Sets several SPRY Mail options.

Show Headers 
as default Specifies whether mail header information is shown. Clear the check box to hide the 

the mail header. (When reading a message, you can view or hide the message header
by clicking the Show Header or Hide Header button.)

Inbox Location Specifies whether Mail stores mail on the remote host, or copies it to your PC. Click 
Choosing an Inbox for more information.

Send Mail By options
Send mail by Specifies whether you send mail using POP3 or SMTP send protocols. See Choosing 

how messages are sent for more information. 

The Return Address box determines what appears in the From: line when your 
message arrives at its destination. You can specify a return address plus a nickname 
using one of the following formats: lucy@narnia.com (Lucy), "Lucy" 
lucy@narnia.com, or Lucy <lucy@narnia.com>, where lucy is your nickname and 
lucy@narnia.com is your e-mail address.

Compose options
Keep a copy of outgoing
messages in "Sent
Mail" folder Specifies whether to automatically store outgoing messages that you send in the Sent 

Mail folder. See Saving Sent Mail for more information.

Message Width Lets you change the width of Mail messages you compose. Mail by default adds a 
carriage return after the 80th character on each line.

Some mail programs can view messages wider than 80 characters. To accommodate 
these programs, use the Column box to enter the number of characters you want to 
display on each line. Select the Current Window Width option to have Mail break 
outgoing messages at the current window width.

Signature File Automatically attaches a signature file (commonly used for your name and contact 
information) to each mail message you send. Use the Signature File box to enter the 
path and filename of a text file, or click the browse button to locate a text file.

The text in the file you specify will automatically be inserted at the end of your 
outgoing messages. You can delete or change the text as you wish.

New Mail options
Check every __ minutes
when working
on-line Specifies how often Mail will check for new messages. The default is 10 minutes.

Notification Changes how you are notified when mail messages arrive. Popup Box displays a 
message box in the middle of the screen. The box will disappear by itself in a few 
seconds, or you can click it with your mouse to make it go away. Sound notifies you 
with a beep or other system sound. (If you have a sound card, you can change the 
sound that is used by choosing Sound in the Windows Control Panel and changing the
SPRY Mail sound.) Flashing Cursor will flash the application cursor when you receive
mail.



Message Headers

Controls how much information you see in the mail messages you receive. Header information provides a variety 
of information about the protocols used to create the message and how it was routed over the Internet. The 
information you see may vary according to the mail program and host being used by the mail sender.

All Displays all the header information.

None Displays none of the header information.

Selection Enables the list box so you can choose which header information you want to see. 



Font 

Specifies the font, size, and style used to display your mail. Fonts can be changed for both the Mailbox(where 
folders and messages are displayed) and the Compose Message window.

Font Type or select a font name. Mail lists the fonts available with the current printer driver 
and additional fonts installed in your system.

Font Style Select a style. To use the default type style for a given font, select Regular. 

Size Type or select a size. The sizes available depend on the printer and the selected font. 
If the size you type is not available on the current printer, Mail chooses the closest 
available size.

Sample Shows the effects of the formatting you specify before you apply it to Mail.

NOTE Fonts in the Compose Message window are for display only—your mail will not be displayed in that font 
when it is received. Only monospaced fonts can be used for the Compose Message window; this ensures
that the message is correctly formatted by Mail before sending).



Toolbar Style

Changes the appearance of the Toolbar buttons to one of three styles:

Both Picture & Text

Picture only

Text only



Confirmation 

Specifies whether confirmation messages are displayed when you delete a message or reply to a message.

Remote Message Delete Determines whether you will be prompted before deleting messages stored in 
the Remote Inbox. When checked, a prompt will appear each time you delete 
a message that is stored in the Remote Inbox.

Reply Method Determines whether you will be prompted for a Reply method when replying to
a message. When this item is checked, whenever you reply to a message a 
prompt will appear asking how you want to reply to the message. 

See Also

Replying to a message
Deleting a message 



Empty Wastebasket on Exit

Controls whether the folder named Waste Basket is automatically emptied when you exit Mail. Place a check by 
this command to empty the wastebasket. 

You should empty your wastebasket from time to time in order to conserve disk space.



Open Message After Delete

Has Mail automatically open the next message when you delete a message that is being read. Place a check by 
this command to open the next message after you delete the current message. This command is ignored when 
you delete a message from Mail’s main window.



Tile, Cascade, and Arrange Icons

These three commands help you manage windows and minimized icons in Mail.

Tile Resizes and arranges the open windows side by side.

Cascade Resizes and layers open group windows so that each title bar is visible.

Arrange Icons Evenly arranges the minimized icons.



Address Book 

Addresses a message to users in the current Address Book. You can also use this dialog box to add, edit, or 
delete an address from an Address Book. 

Search Alias Name Quickly highlights the address in the list that most closely matches the name you 
enter.

Address List Lists all the addresses in the current Address Book.

Select All Highlights all the addresses in the Address Book.

Add Displays the Address Book Detail dialog box for you to create a new address.

Edit Displays the Address Book Detail dialog box for you to edit the address that is 
currently highlighted.

Delete Marks the address that is currently highlighted for deletion. When you press OK to 
close this dialog box, the address is deleted; press Cancel to exit without saving the 
current changes to the Address Book.

Open/New Displays the Open/New Address Book    dialog box for you to open an existing Address
Book or create a new Address Book.

See Also

Overview of address books 



Address Book Detail 

Adds or edits an entry in your Address Book.

Alias Name Type a name for the addressee. Enter a name that is short and easy to remember.

Internet Address Type the Internet address for the addressee.

Paste Pastes the contents from the clipboard.

See Also

Overview of address books 



Open/New Address Book 

Creates a new Address Book or opens a different Address Book.

Filename Select or type the name of an Address Book. 

You can create a new Address Book by typing a filename that does not exist. If you 
don’t specify a file extension, Mail will use an .ALS extension.

Drives Select the drive that contains the file you want to open.

Directories Select the directory that contains the file you want to open.

Network Opens the Connect Network Drive dialog box so that you can make a connection to a 
network drive. For more information, choose the Help button in the dialog box.

Read Only Opens a document as read-only. To save changes you make to a read-only document,
use the Save As command to save it with a new name.

See Also

Overview of address books 



Attach File 

Attaches a file to a mail message. You can attach either a binary or a text file to a message:

The Attach File dialog box attaches a binary file.
The Insert Text File dialog box inserts a text file at the current cursor location.

Filename Select or type the name of the file you want to attach. 

Drives Select the drive that contains the file you want to attach.

Directories Select the directory that contains the file you want to attach.

Network Opens the Connect Network Drive dialog box so that you can make a connection to a 
network drive.

See Also

Attaching a file 



Sending Options 

Specifies whether to request a return receipt, and controls the encoding method used to send the message. These
two options are described below.

Attachment Encoding Specifies the method used to encode any files you attach to your message. You can 
choose either MIME or UUCODE; the method you use depends on the mail program 
the recipient is using. If the recipient’s mailer supports MIME, it is probably the most 
efficient method.

Mail will remember the option you choose and use it for future mail messages until you
change it.

Request Sends a message back to you acknowledging that the mail was received by the 
remote mail server. This does not acknowledge that the person you are sending mail 
to has received the mail, only that the mail arrived at the server.

Mail does not remember this option; you must select this option every time you want to
receive a return receipt. 

See Also

Attaching a file 
Requesting a return receipt 



Save Attached File 

Saves a file attachment (found in the Attachment window of messages you receive) to a file on your system.

File Name Lists the original filename for the attachment. You can type a new name for the file, or 
select an existing name from the list. A filename can contain up to eight characters, 
plus a three-letter extension.

Drives Select the drive where you want to store the document.

Directories Select the directory where you want to store the document.

See Also

Opening and saving an attachment 



Confirm Mail Delete 

Confirms whether or not you want to delete the selected mail message(s) from the Remote Inbox. This dialog box 
will prompt you for each message you’ve selected.

Yes Deletes the current mail message.

Yes to All Deletes all the mail messages you selected. This option only appears if you selected 
more than one message.

No Does not delete the current mail message.

You can disable this prompt by clearing the Remote Message Delete box in the Confirmation dialog box.



Mail Folder Directory 

Specifies the directory used to store your mail folders. This dialog box appears the first time you run Mail.

Directory Mail suggests the subdirectory \...\DATA\MAIL in your installation directory. 

You can specify a different path and filename; if the directory does not exist, Mail will 
create it for you.



SPRY Mail Login 

Logs you into Mail. You must fill out the Host, Username, and Password in order to start Mail.

Host Type the name or IP address of the host on which the POP3 server is loaded. If you 
have a hosts file, any hosts it contains will appear in the Host: box for you to select.

NOTE You may or may not have a hosts file on your system, according to the TCP/IP 
transport you are using and how your system is configured.

Username Fill out your username on the host you specified. Your username may be the same as 
your "login name."

Password Fill out your password on the host you specified.

Options The Work Offline checkbox lets you start Mail and work "offline" without connecting to
your mail host. For security reasons this feature still requires you to login to Mail by 
entering your mail host, username, and password. The Remember Password 
checkbox tells Mail to remember your password so you don’t have to enter it each time
you connect. The next time you start Mail, your password will be entered automatically.

When you click OK, Mail will open the connection to the host that you specify.

 




